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Online Labs

Live Monitoring Console in a Non-Managed Environment

Purpose

Live Monitoring Console is used to monitor live video and to monitor alarms. This online module 
offers structured labs that can be used with an online recorder that demonstrate many of the 
capabilities of the product.

Online Lab Objectives

Once you complete this online module, you will have used key features of VideoSphere Live Monitoring 
Console.

Additional Requirements

In addition to this online lab guide, you will also need to download the file DeviceList.dat that is 
contained in the ZIP file with this lab book. When working in a non-managed environment (no ESM), 
this file must be imported by Live Monitoring Console so that it is able to contact the recorder(s). We 
recommend that you download it to your Desktop.

Also, these labs require the installation of the Professional version of Live Monitoring Console. This 
requires that you enter the license key that is displayed in the online tutorial.

Administrator Console Configuration

For security reasons, alarms and associated cameras for Live Monitoring Console are configured using 
Administrator Console. For this online module, Alarm Input 1 has been named Panic Alarm and 
configured with Cashier 1 as the Primary Camera. To allow physical alarm operation from your remote 
location, Alarm 1 has been “configured” to Switch 1. Force Switch 1 to the On condition to simulate a 
physical alarm on Alarm 1. The switch has been configured to automatically switch Off after 5 seconds.

References for this Module

• Live Monitoring Console 5.5.2 Getting Started Guide

• Administrator Console 5.5.2 User Manual, Chapter 20, “Configuring Alarm Monitoring”
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Scenario

You are a security officer whose job it is to monitor specific areas for activity as detailed below.

Pharmacy Aisle 1

Camera(s): Pharmacy Aisle

Surveillance Required: Watch for possible shoplifting activity

Response Required: Notify loss prevention personnel in the store with details and then log details.

Pharmacy Aisle 2

Cameras: Pharmacy Aisle

Surveillance Required: 

1. Watch for spills and cleanup in aisle

2. Watch for bogus slip-and-fall actions.

Response Required: 

1. Log time and perpetrator of spills

2. Log time that store staff cleans up spill

3. Log time of any bogus slip-and-fall activity

Cashier 1

Cameras: Cashier 1

Surveillance Required: Cashier reports are irregular; watch for improper actions as merchandise is 
checked through.

Response Required: Log time and suspicious actions
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Lab 1: Download the Software

In order to install these client tools, you first need to download the software ZIP file to a folder and then 
unzip it.

1 Included with this lab book is a device list file entitled DeviceList.dat. Unzip this file onto the 

Desktop of your computer.

2 Create a folder on your hard drive entitled R5 Standard CD.

3 Access the latest R5 CD ZIP file available on the Partners web site by doing one of the following:

a) Go to the March Networks Partners site at http://Partners.MarchNetworks.com

b) Click Technical Support.

c) Under Software Downloads, click R5 Fixed Devices.

d) Locate the most recent R5 release and then click Download.

4 In the File Download dialog box, click Save.

5 In the Save As dialog box, browse to the R5 Standard CD folder you created in Step 1 above.

6 Click Save.

Lab 2: Install Live Monitoring Console

When you have completed this lab, you will have installed the Professional version of Live Manager Console 
on your computer and you will be ready to start the labs associated with this product.

NOTE: In order to install the Professional version of Live Monitoring console, you require the license 
key that you recorded from the online tutorial.

1 In the R5. Standard CD folder, double-click setup,exe.

NOTE: This displays the Software Installation GA Release menu.

2 Click Install VideoSphere Visual Intelligence Applications and then click Live Monitoring 

Console.

3 In the Welcome box, click Next and then, in the Software License Agreement box, click Yes.

4 In the User Information box, type your name and your company’s name and then click Next.

5 In the Registration Key dialog box, type the license key that you recorded from the online tutorial.

6 In the Choose Destination Folder dialog box, click Next

7 In the Question dialog box, asking, “Are you using Enterprise Service Manager?”, click No.

8 Wait while the software installs and then, in the Setup Complete dialog box, ensure the Launch the Live 

Monitoring Console checkbox is selected and then click Finish.
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Lab 3: Set the Environment

This lab demonstrates some of the various interface configurations available to the user. Use the following 
steps to configure a suitable environment for each of the three scenarios detailed above.

1 Start Live Monitoring Console.

2 On the File menu, click Import Device List.

3 Browse to the Desktop and then select the device list file, Device_List_File.dat (the one that is 

contained in the ZIP file with this lab book and that you unzipped to tyour desktop in a previous 

lab). 

4 Ensure the Sites button is selected (beneath the File and View menus).

5 In the Site Selector panel, expand the path from My Sites to the Store site.

6 Select the Store site (this shows the ATM camera group as well).

NOTE: If challenged, type viewer as the password to access the device.

7 In the Camera Selector panel at the lower left, you should be able to see nine 

cameras listed.

TIP: You can reduce the size (by dragging) of the Site Selector panel so that 
the Camera Selector panel is able to display more cameras.

8 Drag a camera from the Camera Selector panel onto the grid.

9 If the Alarm Inbox is not displayed at the bottom of the window: on the 

View menu, click Alarm Inbox.

10 On the View menu, click Sites to hide the Sites panel and expand the grid to full screen.

11 Display the Controls sub-panels.

a) Display the Controls Panel by clicking the Controls button (beside the Sites button).

b) Display sub-panels within the Controls panel: On the View menu, point to Control Panels and then, 
for Control Panels not yet displayed:

i Click Alarm Inspector . This panel displays all the alarms available at your site.

ii Click Switch Controls . This panel enables you to control switches at your site.

iii Click Audio Controls . This panel enables you to monitor audio at, and to send audio to, 

the site.

iv Click PTZ Presets . This panel enables you to direct PTZ cameras to presets.

e) Ensure the Alarm Inspector and the Switch Controls panels are displayed before continuing.

12 Display the different toolbars you have available:

a) On the View menu, point to Toolbars. Observe that, because the Alarm Inbox is displayed, the 
Alarm Response toolbar is displayed by default at the bottom of the Alarm Inbox.
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b) On the View menu, point to Toolbars and then click:

i Control Mode. This displays, above the Alarm Inspector panel, the icon for each of the 4 Control 
Panels opened above.

ii Display. This displays, the display toolbar along the right side of the grid.

iii Playback. This displays the Playback toolbar above the grids. You will see that, in addition to 
playback controls, it also contains icons for some of the more commonly used menu options. 
Ensure the Playback toolbar is displayed before continuing.

iv Status. This displays the Status Bar at the bottom of the window.

v Timeline. This displays the Timeline above the Playback toolbar.

vi Video Picture Controls. This displays the Video Picture Controls between the Timeline and the 
Grid. Video Picture Controls can also be toggled using the top button on the Display toolbar.

13 On the playback toolbar, set the grid to either 2x2 or larger.

14 To display/hide cell title bars, on the View menu, click Video Display Cell Title Bars. This displays a title 

bar atop each cell in the grid. The title bar displays the name of the camera, the view (either live or the 

length of the delay, the “pin” icon, a live or archive icon and the Clear Video button). You can also click 

the Show/Hide Title Bars button  to the right of the Grid Layout button.

15 As your job involves monitoring multiple cameras, select the 1+5 Grid Layout. This allow you to 

monitor all five cameras while having a larger cell available if you need it. 

NOTE: Here are some techniques to populate that large cell from a smaller cell (the techniques work on 
any cells in any multi-camera grid layout).

a) On the View menu, hide the Alarm Inbox (to give a larger video display area).

b) Ensure the Grid Layout is set to 1+5.

c) Drag each camera into its own small cell leaving the large cell empty.

d) Assume that an action in the Pharmacy Aisle camera has attracted your attention and you’d like to 
see it in a larger format.

e) Drag the Pharmacy Aisle camera from the small cell into the large cell.

f) Observe the result on the smaller “source” cell.

g) Drag the Entry - Side camera from the small cell into the large cell.

h) Observe the result on the smaller “source” cell.

i) Repopulate the empty cells with their original cameras.

j) As an alternative to ‘moving’ the camera and leaving the source cell empty, you might like to ‘copy’ 
the camera from the smaller cell to the larger cell. Press and hold CTRL and then drag the Pharmacy 
Aisle camera from the small cell into the large cell.

k) As a further alternative to ‘moving’ or ‘copying’ the camera from the small cell to the large cell, you 
can swap cells. Press and hold CTRL+SHIFT and then drag the Entry - Side camera from the small cell 
into the large cell.

l) Observe that the cameras simply trade places.
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Lab 4: Float the Grid and Alarm Inbox

This lab demonstrates the float feature of the Grid and the Alarm Inbox. This is very useful if you have two 
or more monitors.

1 Click the Float button and then click Float Grid.

2 Place the mouse pointer in the title bar of the window and drag it a bit left or right or down. If a second 

monitor is available, drag the floating window to that screen.

3 Drag cameras from cells on one Grid to cells on the other.

4 Click the Float button and then click Float Alarm Inbox.

5 Drag this floating Alarm Inbox to your second monitor (if available).

6 Click Dock Alarm Inbox  (at the right top of the Alarm Inbox) to dock the Alarm Inbox.

7 On the floating Grid window (labelled Grid 1 in the Title Bar, click Close to close the floating Grid.

TIP: The floating grid is the one that is missing both the Sites button (on the left) and the Float button 
(on the right).

Lab 5: Investigate a Physical Alarm

This lab demonstrates some of the response options available to an operator in the event of an alarm.

1 On the Grid menu of Live Monitoring Console, click Clear All Video Display Cells (or just press 

CTRL+D).

2 If the Alarm Inbox is not displayed (below the preview pane, unless it has been floated), click View 
and then click Alarm Inbox.

3 On the Alarm Monitoring menu, click Activate Alarm Monitoring (or click the Activate/Deactivate 

Alarm Monitoring button near the middle of the Status Bar).

4 To generate a physical alarm, use the Switch Controls in the Controls pane of Live Monitoring Console 

to close Switch 1. Use the following procedure:

a) If the Sites panel is not displayed, click the Sites button to display it.

b) In the Sites panel, expand the Site Selector tree and then select the Store site.

c) From the Camera Selector area below the Site Selector, drag a camera onto one of the cells in the grid 
(Cashier 1 is a good choice although any camera will do).

d) Click the Controls button to display the Controls panel.

e) In the Switch Controls page, select Switch 1 and then click Force On.

NOTE: The switch has been configured (using Administrator Console) to automatically switch Off after 
5 seconds.

f) Watch for the alarm to appear in the Alarm Inbox.

g) Select the alarm entry in the Alarm Inbox and then click Respond.

NOTES If you wish to silence the audible alarm, click Reset New Alarm Notifications.

If you have clicked Respond in error, you can click Release to return the alarm to the Alarm 
Inbox. Click Respond again, if necessary, to re-engage the alarm in your own console.
6 | VideoSphere NVR 5.5.2 Client Tools Lab Book



You can click Suspend to suspend the alarm so that you can work on an alarm of a higher 
priority or for other reasons. Click Activate to return to handling the alarm.

5 Click Play to view some of the video.

6 To close out the alarm, click Finish and then, in the Finish Alarm dialog box, click Yes to copy the 

evidence to a case. This makes the case and its accompanying evidence available in Evidence Manager.

7 Note the location of the saved evidence in your My Documents\My Investigations\Alarms folder.

NOTE: If you do not wish to save the video, in the Finish Alarm dialog box, click No to just finish the alarm.

8 Click OK to close the Exported Case information box.

Lab 6: View Older Video Using Timeline

This lab demonstrates how to control the display and playback of video while monitoring.

NOTE: Timeline controls allow instant replay of up to 30 seconds. Live video in any cell can be paused 
for up to five minutes. Cell title bar indicates how many seconds the display is behind live video.

1 Ensure the Timeline toolbar is displayed (View-Toolbars-Timeline).

2 Press CTRL+D to clear the grid.

3 Reload the grid with some cameras from the Camera Selector panel.

4 Select one of your video cells which contains “live” video.

5 Display the title bars (if not shown) by clicking  on the Playback bar.

6 On the Playback bar, click Pause to make the time slider more obvious (in the Timeline).

7 Observe the time display in the title bar of the active cell.

8 Drag the slider in the timeline towards the left hand side of the Timeline.

9 Observe again the time display in the title bar of the active cell.

10 Click Jump to Live  on the playback control bar to bring you back to live video.

11 Once you are viewing Live video again, click  and monitor your timeline.

12 Click Play and then click Play Speed  and the 2x to play through the video at a faster (while 

catching up to “live”) or .5x to play through the video at a slower speed (to clarify detail).

Lab 7: Pin video cells

This lab demonstrates the feature of pinning a video cell to prevent its contents from being replaced by an 
alarm event.

1 On the File menu, click Preferences and then click the Alarm Management tab.

2 Under When responding to new alarms, clear the Clear the main grid check box and then click OK.

3 Press CTRL+D to clear the grid and then select 1 x 1 from the Grid Layout list (on the Playback 

toolbar).

4 Drag your Entry - Side camera into the grid.
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5 Click Pin/Unpin Video Display Cell  on the title bar of the cell to pin the video in the cell.

6 Trigger the physical alarm to create an alarm.

7 Respond to the alarm in your Alarm Inbox.

• Do you see something similar to the following dialog?

8 Click OK to close the box and then close Live Monitoring Console.

9 If necessary, click Yes to close the Exit Application -Active Alarms box.

Conclusion

This module has demonstrated the following features of Live Monitoring Console:

• Configure the LMC environment to suit the requirements of individual installations.

• Float the grid and Alarm Inbox to other screens, if available.

• Configure physical alarm monitoring and respond to a physical alarm.

• View archive video using the timeline.

• Pin video cells to keep them from being replaced by new alarm video in the event of an alarm.
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Online Labs

Evidence Manager & Investigator

Purpose

Loss prevention officers are frequently required to search for video in response to incident reports and 
to assemble evidence in the form of clips, images and notes to prepare cases for senior management or 
police. This module demonstrates how to use Investigator to search for and manage evidence, Evidence 
Manager to manage the case and Evidence Reviewer to view the evidence.

Online Lab Objectives

Once you complete this module, you will be able to:

• Use Evidence Manager and Investigator to conduct a “full” search for evidence by Time and 
Location.

• Use Evidence Reviewer to view stored evidence

Additional Requirements

In addition to this online lab guide, you will also need to download the file DeviceList.dat that is 
contained in the ZIP file with this lab book. When working in a non-managed environment (no ESM), 
this file must be imported by Investigator so that it is able to connect to the recorder(s). We recommend 
that you download it to your Desktop.

Also, these labs require the installation of the Professional versions of Evidence Manager and 
Investigator. This requires that you enter the license key that is displayed in the online tutorial.

Administrator Console Configuration

For security reasons, alarms for Live Monitoring Console are configured using Administrator Console. 
For this online module, Alarm Input 1 has been named Panic Alarm and configured with Cashier 1 as 
the Primary Camera.

References for this Module

• Evidence Manager and Investigator User Manual

• Release Notes VideoSphere R5
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Scenarios

Use these scenarios to perform the labs that follow. It is not necessary to complete labs for all scenarios.

Your job as a security officer is to locate and extract video in response to event reports from 
investigators. Complete the labs using one or more of the scenarios (Lab 3 needs to be done only once.)

Scenario 1

Location: Store

Cameras: Pharmacy Aisle

Estimated time period (if any): Unspecified

Watch for (description of event): 
Couple enter pharmacy aisle at top and woman was observed placing merchandise in a shoulder bag

Save video: Showing hiding of merchandise; include 10-20 second lead and trailer video

Scenario 2

Location: Store

Cameras: Pharmacy Aisle

Estimated time period (if any): Unspecified

Watch for (description of event): 

1. Incident where jar broke putting liquid on aisle

2. Activity by store staff to clean up spill

3. Male in dark jacket claims slip and fall on liquid in aisle. Store confirms that customer dropped and 
broke jar of jam in aisle but was quickly cleaned up.

Save video: 

1. Showing jar breaking; include 10-second lead and 10-second trailer; ensure time stamp is visible

2. Showing cleanup actions; include 10-second lead and 10-second trailer; ensure time stamp is visible

3. Showing any male in dark jacket in aisle; from entry into aisle to exit from aisle

Scenario 3

Location: Store

Cameras: Cashier 1

Estimated time period (if any): Unspecified

Watch for (description of event): 
Cashier reports are irregular and suggest improper actions.

Save video: 
Extract video of any actions inconsistent with cash management and/or customer service policies. If 
customer present, include time from when customer begins checkout until check out is concluded. If 
no customers are in process of checking, include 15 seconds before and 15 seconds following the 
specified actions.
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Scenario 4

Location: Drive Thru ATM

Cameras: Drive Thru - License and Drive Thru - Face

Estimated time period (if any): Around midnight

Watch for (description of event): 
Police are investigating a hit and run that took place at an intersection near our store. They are looking 
for video of vehicles and drivers using our ATM around midnight last night.

Save video: 
Extract face and license video of all activity at our ATM between 11:55 pm and 12:05 am. If beginning 
or end time occurs in the middle of a customer transaction, include video of the entire transaction 
time. 

Lab 1: Install Evidence Manager and Investigator

When you have completed this lab, you will have installed the Professional versions of Evidence Manager 
and Investigator on your computer and you will be ready to start the labs associated with this product.

NOTES If you have not already downloaded the R5 Standard CD see “Lab 1: Download the Software” 
on page 3.

In order to install the Professional versions of Evidence Manager and Investigator, you require 
the license key that you recorded from the online tutorial.

1 In your R5 Standard CD folder, double-click setup.exe.

NOTE: This displays the Software Installation GA Release menu.

2 Click Install VideoSphere Visual Intelligence Applications and then click Investigator and 

Evidence Manager.

3 In the Welcome box, click Next and then, in the Software License Agreement box, click Yes.

4 In the User Information box, type your name and your company’s name and then click Next.

5 In the Registration Key dialog box, type the license key that you recorded from the online tutorial.

WARNING: This license key is for training purposes only.

6 In the Choose Destination Folder dialog box, click Next

7 In the Question dialog box, asking, “Are you using ENterprise Service Manager?”, click No.

8 Wait while the software installs and then, in the Setup Complete dialog box, ensure the Launch 

Evidence Manager checkbox is selected and then click Finish.
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Lab 2: Use Evidence Manager to Create Case Folders

This lab demonstrates Evidence Manager’s capability to create a case folder. You will want to create a case 
folder for each of the scenarios detailed above.

1 If Evidence Manager has not been started, start it now.

2 Click My Case Folders in the left panel.

3 Create a new case folder for each scenario by clicking New Folder .

4 Name the case folder as indicated in the following table:

5 Double-click the required case folder to activate it and to enable the Investigate button (on the right).

Lab 3: Import a Device List File into Investigator

This lab demonstrates starting Investigator from within Evidence Manager and then importing a device list 
file to enable Investigator to connect to a site. This action imports all cameras from the Store location and 
needs to be done only once, regardless of which scenarios you choose to do.

1 If you haven’t yet started Investigator, from within Evidence Manager, click Investigate.

2 On the File menu, click Import Device List and then select the device list file, Device_List_File.dat (the 

one that is contained in the ZIP file with this lab book and that you unzipped to tyour desktop in a 

previous lab). 

3 Click Open (or just double-click the filename).

4 If the My Sites panel is not displayed, click anywhere in the title bar to open the panel.

5 Expand My Sites (click +) until you see the Store site and then select the site.

6 If required, type viewer as the password to access the recorder.

Lab 4: Use Investigator to Search for Video Evidence

This lab continues from the previous lab and demonstrates how to search for evidence by time and location.

1 Select a scenario from the list of scenarios.

2 In the Camera Selector, select the camera indicated in the scenario.

3 Click the title bar of the My Sites panel to minimize it (optional, but provides larger preview panel).

4 Click View Live Video  (the right-most button below the Video Activity bar).

5 Close this live video window or move it aside or to another screen. You won’t need it again.

Scenario Folder name

1 Pharmacy Shoplift

2 Slip and Fall

3 Cashier 1 Irregularities

4 Drive Thru ATM
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6 Ensure the Search Type is Search by Time and Location (default).

7 In the Time Period Selector and Preview Area panel, select yesterday’s date from the calendar (ensure 

the month and year are current) and then wait while Investigator contacts the recorder and populates 

the Recorded Data and Video Activity bars.

NOTE: The green color in the Recorded Data bar indicates that the camera was working during the 
period indicated; the blue in the Video Activity bar indicates motion.

8 Observe that the Video Activity bar is solid blue, indicating a lot of motion.

9 Because the Video Activity bar is solid (indicating full motion), try reducing the time intervals of the 

Timeline: Click the 5 Minutes button to reset the timeline to 5-minute intervals and then select one of 

the 5-minute intervals.

NOTE: The Video Activity bar should now display areas of blue interspersed with areas of grey. The blue 
areas represent periods of activity.

10 In the Video Activity Bar, click an area of blue to view a single image or select a time period (drag) to 

select a clip (you will need to click Play to see a clip).

NOTES Detail beneath the Video Activity bar indicates the starting date and time of the clip, its 
duration and its approximate size (or the date and time of the image).

You can also use the Thumbnails feature to speed your search. This displays seven thumbnail 
images from within the selected time. Selecting a thumbnail automatically selects a clip on the 
timeline.

11 Use your mouse to select a few minutes of video in the Recorded Data/Video Activity bars and then save 

the clip by clicking Save Evidence.

TIP: Click the arrow at the right of the button to display more options.

12 In the Camera Selection box, ensure that the required camera is selected.

NOTE: You can select additional cameras from which to download video for the same time period.

13 In the Enter evidence note text below box, type some relevant text and then click Start Download.

14 Observe the progress of the downloads (just below the Evidence Note title) and then, when Download 

is complete is displayed, click OK to close the Evidence Note dialog box.

Lab 5: Use Investigator to Queue Evidence on a Recorder

This lab demonstrates how to queue evidence on a recorder for transfer to a USB-attached device. This 
allows the investigator to export evidence at the recorder site (convenient to local police service).

1 In the Video Activity Bar, select an area of blue (indicating video activity) that is about 3-4 minutes in 

length (less than 1 MB in size).

2 On the Save Evidence menu (button to the right of Evidence beneath the calendar), click Queue 

Evidence on Device.
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3 In the Evidence Note box, type a comment of your choice.

4 Click OK to close the Evidence Note box.

5 Click Manage Queued Evidence  (second button to right of Case) and then, in the List 

Evidence to Copy box (near the top), select Evidence for Revision.

6 If there is more than one entry in this list, check the Status column to locate a clip that is Not copied and 

then select that item.

7 Under External Media Status, verify that a USB Drive is available.

8 Ensure that the Include Evidence Reviewer checkbox is selected and then select the Erase USB 

Drive before copy checkbox.

9 Click Start Copy.

10 In the Confirm Erase Flash Drive Contents warning box, click OK.

11 Track progress under Device Status in the Status frame of the Manage Queued Evidence box.

12 Wait until the Status column shows Copied (this takes a few minutes) and then click Remove Copied.

13 Click Close to close the Manage Queued Evidence box.

14 Close Investigator.

NOTE: This returns you to Evidence Manager.

Lab 6: Use Evidence Manager to Add and Organize Case Notes

This lab demonstrates how to copy evidence to a CD on the Investigator’s computer.

1 Close Investigator.

2 In Evidence Manager, drag the clip into the Media Viewer window.

3 Add another case note:

a) On the Case Notes toolbar, click Add Note ;

b) Optionally, select the Link to...” checkbox to link this note not only to the selected clip but to the 
specific part of the clip that is currently displayed.

c) Click OK to close the Case Note dialog box.

d) Select each note and then use the up- and down-arrows in the Case Notes toolbar to position the 
notes where you would like them.

NOTE: Once you have organized your evidence with case notes, you can burn the case to CD (on the PC 
hosting Evidence Manager) by clicking Burn CD and then follow the steps of the Windows XP 
direct CD burning feature.

4 Close Evidence Manager.
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Lab 7: Use Evidence Reviewer to Review Evidence

This lab demonstrates how to view saved evidence using Evidence Reviewer.

1 Install Evidence Reviewer. Revisit “Lab 1: Install Evidence Manager and Investigator” on page 11, if 

necessary for guidance on the installation.

2 Start Evidence Reviewer. 

3 If the Case Folders directory is not already pointing to the location of the evidence you saved in a 

previous lab, change to that folder by clicking Case Folders.

NOTE: The default folder is My Documents\My Investigations.

4 Drag the video clip or image into the Media Viewer, or click a case note to view the media associated 

with the Note.

5 On the toolbar to the right of the Case Folders button, click Validate Media and observe the response.

6 Close Evidence Reviewer.

Lab 8: Use Investigator to Search for VMD Events

This lab demonstrates how to search for video evidence by motion alarm and is not related to the scenarios 
detailed at the beginning of the module. 

The Cashier 1 camera has been configured for motion detection, so there will be motion alarms in the 
Motion Events list.

1 Start Investigator directly from the Desktop.

NOTE: This is called a “Quick Investigation”.

2 Click Search Type and then select Search by Motion or Alarm.

3 Click the My Sites title bar to open the Site Selector/Input Selector panels and then, in the Input 

Selector, click the Cashier 1 camera with Type VMD (ensure Type is VMD not Area Obstruction).

4 Select yesterday's date and time and click Search. 

• You should see results in the Motion Events panel that look something like this.

5 Double-click an event to view the associated video.

NOTE: Once you find the evidence, you can save it in the regular way.
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Conclusion

This module has demonstrated the following features of Evidence Manager and Investigator:

• Install Evidence Manager and Investigator

• Create case folders using Evidence Manager

• Import a Device List File into Investigator

• Use Investigator to search for video evidence

• Use Investigator to queue evidence on a recorder

• Use Evidence Manager to add and organize Case Notes

• Use Evidence Reviewer to view evidence

• Use Investigator to search for VMD events
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